
 

To our customers, 
 

Old Company Name in Catalogs and Other Documents 

 
On April 1st, 2010, NEC Electronics Corporation merged with Renesas Technology 

Corporation, and Renesas Electronics Corporation took over all the business of both 
companies. Therefore, although the old company name remains in this document, it is a valid 
Renesas Electronics document. We appreciate your understanding. 
 

Renesas Electronics website: http://www.renesas.com 
 
 
 
 

April 1st, 2010 
Renesas Electronics Corporation 

 
 
 
 
 
Issued by: Renesas Electronics Corporation (http://www.renesas.com) 

Send any inquiries to http://www.renesas.com/inquiry. 

 



Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 
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consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
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“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
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“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
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The information in this document is current as of September, 2007. The information is subject to 
change without notice.  For actual design-in, refer to the latest publications of NEC Electronics data 
sheets or data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not 
all products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior       
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual property 
rights of third parties by or arising from the use of NEC Electronics products listed in this document or any 
other liability arising from the use of such products.  No license, express, implied or otherwise, is granted under 
any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a 
customer-designated "quality assurance program" for a specific application.  The recommended applications of 
an NEC Electronics product depend on its quality grade, as indicated below.  Customers must check the quality 
grade of each NEC Electronics product before using it in a particular application. 

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)

•

•

•

•

•

•

M8E  02. 11-1

(1)

(2)

"NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 
majority-owned subsidiaries.
"NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 
defined above).

Computers, office equipment, communications equipment, test and measurement equipment, audio
and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.
Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).
Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

"Standard":

"Special":

"Specific":
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INTRODUCTION 
 

 

Target Readers  This manual is intended for users who wish to design and develop application 

systems using the 78K0R microcontrollers.  

 

Purpose  This manual’s purpose is to help the user understand the functions and the 

operation method of the AZ78K0R.  

 

Organization  This manual is organized as follows.  

 

• General 

• Installation 

• Functions 

• Window reference  

• Error information  

 

How to Use this Manual  This manual assumes that the reader has general knowledge of microcontrollers, 

C language, assembly language, and debugging as well as basic knowledge of 

the Windows operation method.  

 

 To learn about the hardware functions and instruction functions of the 78K0R 

microcontrollers:  

  → Read the user’s manual for each product.  

 

Conventions  <  >: Indicates a window or dialog box title.  

 [    ]: Indicates a menu.  

  text  : Indicates a button in a window or dialog box.  

 <<  >>: Indicates a character string displayed in a window or dialog 

box.   

 Data significance: Higher digits on the left and lower digits on the right 

 Memory map addresses: Higher addresses on the top and lower addresses on 

the bottom 

 Active low representation: xxx (overscore over pin or signal name)   

 Note: Footnote for item marked with Note in the text  

 Caution: Information requiring particular attention  

 Numerical representation: Binary...XXXX or XXXXB  

  Decimal...XXXX 

  Hexadecimal...0xXXXX  

 Prefix indicating power of 2 (address space, memory capacity)  

  K (Kilo) 210 = 1024 

  M (Mega) 220 = 10242  
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Related Documents  Please use the following documents in conjunction with this manual.  

 The related documents listed below may include preliminary versions. However, 

preliminary versions are not marked as such.  
 

Documents Related to 78K0R microcontrollers Development Tools (User’s Manuals)  

Document Name Document No. 

Operation U17838E CC78K0R  C Compiler 

Language U17837E 

Operation U17836E RA78K0R  Assembler Package 

Language U17835E 

SM+  System Simulator Operation U18010E 

Functionalities U18317E 

Internal Structure U18318E 

RX78K0R  Real-Time Operating System 

Task Debugger U18454E 

AZ78K0R  System Performance Analyzer This document 

PM+  Project Manager U17990E 

ID78K0R-QB  Integrated Debugger Operation U17839E 
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CHAPTER 1  GENERAL

1. 1  Overview

As the performance of microprocessors has increased, application programs have grown in scale and complexity.

With conventional debuggers, theoretical debugging of such application programs is simple, but time-related analysis is 

not. It is difficult and takes a very long time, for example, to analyze errors such as those caused by incorrect processing 

timing, or to evaluate the performance of the entire system.

To solve these problems, NEC Electronics Corporation has developed powerful microprocessors such as the 78K0R 

Microcontrollers. NEC Electronics Corporation has also developed "System Performance Analyzer: AZ78K0R", to support 

the quantitative performance analysis of application programs.

The AZ78K0R is a performance analysis tool for examining the execution transition statuses and the CPU usage of 

processing programs that embed the RX78K0R real-time operating system for the 78K0R. Being connected with a 

conventional debugger, the AZ78K0R achieves a function for collecting data of tracing the event occurrences (issuance of 

service calls, occurrence of interrupts, etc.) and presenting the trace data graphically.

The AZ78K0R therefore allows the user to readily analyze the execution transition statuses and the CPU usage of 

processing programs.

Since the AZ78K0R employs the Tool Interface Protocol (TIP) for connection with a debugger, it can be connected with 

debuggers made by manufacturers other than NEC Electronics, as long as the debugger supports this interface, and can 

use the relevant functions.
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1. 2  Features

The AZ78K0R has the following features:

- Display of execution transition statuses

The graphically displayed the execution transition status of the processing program in which the RX78K0R is 

embedded (horizontal axis = time, vertical axis = task name, etc.) permits analysis of execution transition statuses, 

such as task switching caused by service call issuance and transferring the control to the interrupt handler caused 

by the occurrence of interrupts. Since all accesses to an object (such as semaphore or eventflag) are marked 

upon issuance of a service call from a processing program, the usage of objects can also be checked.

- Display of CPU usage

The CPU usage (total execution time, code coverage, etc.) of a processing program executed within a specified 

section can be displayed, which enables the quantitative performance analysis for processing programs.

- Linking with debugger

The AZ78K0R can open the Source window, Assemble window and Memory window of the linked debugger, 

which enables quick identification of locations where a problem has occurred.
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1. 3  System Configuration

The AZ78K0R extends the function of the debugger by communicating with it on the TIP specification.

The following shows the AZ78K0R system configuration for debug environments.

Figure 1-1  System Configuration (When Using Simulator)

[Note] When using SM+, the Add Up Timtag check box must be cleared in the Extended Option dialog box, and the 

Timtag check box must be selected in the Trace Data Select dialog box in SM+.

Figure 1-2  System Configuration (When Using In-circuit Emulator/On-chip Debug Emulator)

[Note] When using ID78K0R-QB, the Timtag check box must be selected in the Extended Option dialog box in the 

ID78K0R-QB.

Real-time OS

C compiler

AZ78K0R

Host machine

Simulator

Assembler

On-chip debug emulator

Target system

Real-time OS

C compiler

AZ78K0R

Debugger

Assembler

Host machine

In-circuit emulator/
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1. 4  Execution Environment

The following shows the AZ78K0R operating environment required for executing the quantitative performance analysis 

for processing programs.

(1) Hardware

- Host machine

The machine by which the target OS operates.

- In-circuit emulator

IECUBE series (from NEC Electronics Corporation)

[Note]  In-circuit emulators other than the above can be connected to the AZ78K0R, as long as they 

support TIP.

- On-chip debug emulator

MINICUBE2 (from NEC Electronics Corporation)

[Note]  On-chip debug emulators other than the above can be connected to the AZ78K0R, as long as 

they support TIP.

- Target system

Target system in which 78K0R is incorporated.

(2) Software

- OS (any of the following)

Windows® 2000, Windows XP Home Edition, Windows XP Professional

[Note] It is recommended that the newest Service Pack be installed in any of the above OSs.

- C compiler

CC78K0R (from NEC Electronics Corporation)

- Assembler

RA78K0R (from NEC Electronics Corporation)

- Real-time OS

RX78K0R (from NEC Electronics Corporation)

- Debugger

ID78K0R-QB (from NEC Electronics Corporation)

[Note] Debuggers other than the above can be connected to the AZ78K0R, as long as they support TIP.

- Simulator

SM+ for 78K0R (from NEC Electronics Corporation)

SM+ for 78K0R/Kx3 (from NEC Electronics Corporation)

[Note] Simulators other than the above can be connected to the AZ78K0R, as long as they support TIP.
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CHAPTER 2  INSTALLATION

2. 1  Installing

This section explains how to install the AZ78K0R.

To install the AZ78K0R again, uninstall it first.

(1) Start Windows

Power on the host machine and peripherals and start Windows.

(2) Set supply media

Set the supply media in the appropriate drive (CD-ROM drive, etc.) of the host machine.

(3) Start setup program

The setup program will start automatically.

Perform the installation by following the message displayed in the monitor screen.

[Note] If the setup program does not start automatically, execute Install.exe on the supply media from 

Windows Explorer.

(4) Check files

Using Explorer, etc., check the files provided on the supply media has been installed on the host machine.

[Note] For detailes on the files installed on the host machine, refer to "2. 3 File Configuration".
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2. 2  Uninstalling

This section explains how to uninstall the AZ78K0R.

(1) Start Windows

Power on the host machine and peripherals and start Windows.

(2) Open Control Panel window

Select [Control Panel] from the Start menu of Windows to open the Control Panel window.

(3) Open Add or Remove Programs window

Double-click the "Add or Remove Programs" icon in the Control Panel window to open the Add or Remove 

Programs window.

(4) Remove components

Select the components shown below from the list displayed in the Add or Remove Programs window, and then 

click the [Remove] button.

Follow the messages displayed on the monitor screen to continue uninstallation.

- AZ78K0R System Performance Analyzer V4.xx Components

- AZ78K0R (V4.xx) Document Components
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2. 3  File Configuration

The following shows the file configuration when the files stored in the supply media has been installed.

Figure 2-1  AZ78K0R System Performance Analyzer V4.xx Components

Figure 2-2  AZ78K0R (V4.xx) Document Components

tipdbg.dll

tipxdbg.dll

tipcmm.dll

Installation folder (default: C:\Program Files\NEC Electronics Tools\AZ78K0R\V4.xx)

bin

hlp

AZ78K0R online help file

AZ78K0R execution format file

Libraryfile of the PM+ for the AZ78K0R

Windows system folder (default: C:\WINDOWS\system32)

Library file of TIP processing for the AZ78K0R and RD78K0R

TIP processing library for extended debugger

Library file of TIP processing for common

az78k0r.exe

az78k0r.chm

az78k0rp.dll

ZUD-CD-xx-xxxx.pdf

Uxxxxxxxxxxxxxx.pdf

Installation folder (default: C:\Program Files\NEC Electronics Tools\AZ78K0R\V4.xx)

doc

User's manual

Restrictions and cautions
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CHAPTER 3  FUNCTIONS

3. 1  Trace Form

The AZ78K0R supports the following trace form.

- Hard trace form

Using the qualify trace function provided by the simulator or in-circuit emulator, the AZ78K0R collects trace data 

and stores it to the trace buffer of the simulator or in-circuit emulator.

Using this form, trace data can therefore be collected without modifying the processing program code.

[Note] The AZ78K0R uses the following simulator/in-circuit emulator resource, when switching the AZ trace 

mode to the ON state.

Table 3-1  Resources Used by AZ78K0R

3. 2  Trace Data

3. 2. 1  Collecting positions and collected data

The following lists the trace data to be collected and positions where they are collected.

Table 3-2  Collected Trace Data and Collecting Positions

Resource Name Remark

Qualify trace condition 1 (for write access)

Collecting Positions Collected Data

Service call entry Time

Service call function code

ID of object subject to execution by service call

Service call issuance address

Service call exit Time

Service call return value

Interrupt handler entry Time

Address at which execution returns from interrupt handler

Interrupt handler exit Time

Occurrence of task switching Time

ID of a task to which the operation will move (or ID that indicates idle 

routine is entered)
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Note that the following items cannot be detected as trace data in the AZ78K0R.

- Address at which ext_tsk is issued

- Entry/exit of reset, NMI, exception (software exception, exception trap)

- Entry/exit of maskable interrupts whose interrupt handler has not been registered

- Boot processing entry/exit

- Initialization routine entry/exit

- Cyclic handler entry/exit

Since the RX78K0R assigns the same function code to service call names to which an "i" is prefixed/not prefixed listed 

below, the AZ78K0R cannot identified them.

The AZ78K0R therefore handles these service calls without an "i" being prefixed.

- sta_tsk/ista_tsk

- chg_pri/ichg_pri

- can_wup/ican_wup

- sus_tsk/isus_tsk

- rsm_tsk/irsm_tsk

- frsm_tsk/ifrsm_tsk

3. 2. 2  Time accuracy

The accuracy of the time collected as trace data is the same as that of the time tag that is used for the qualify trace 

function provided by the simulator or in-circuit emulator.

If the system clock is set to the STOP or IDLE mode, however, the AZ78K0R cannot collect an accurate time, and the 

collected value is therefore not guaranteed. (This is because the AZ78K0R calculates the time taken by processing 

program execution, based on the system clock.)

[Note] Some in-circuit emulators do not support the time tag for trace data. In such a case, set the display mode of 

the AZ:Analyze window to "Equal mode"; the task execution status can then be checked.

Task entry Time

ID of task to be activated

Task activation address

Collecting Positions Collected Data
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3. 3  Debugging Procedure

This section describes the procedure for debugging using the AZ78K0R.

(1) Starting the debugger

Start the debugger to be used.

For details on the debugger startup method, refer to the user’s manual for the debugger.

(2) Starting the AZ78K0R

Start the AZ78K0R to be used.

The following two methods are available to start the AZ78K0R.

- Starting from Start menu

Click the Windows Start menu, point to [All Programs], [NEC Electronics Tools], [AZ78K0R], [V4.xx] and 

click [AZ78K0RV4.xx] (default), or click the Windows Start menu, point to [All Programs], [NEC Electronics 

Tools], [Latest Version], and click [AZ78K0R V4.xx].

- Starting from PM+

The procedure to start the AZ78K0R is as follows.

(a) Start PM+ and then load a workspace file (*.prw).

(b) Click [Tool] in the main window of PM+ and then select [Startup AZ78K0R]

[Note] When the AZ78K0R is started via PM+, the version can be checked in the Project Settings dialog 

box (Tool Version Settings tab) of PM+.

After the AZ78K0R is started, the following AZ78K0R window appears.

At this time, make sure that the message "Connected" is displayed on the status bar (Connection status area) in 

the AZ78K0R window.

Figure 3-1  Starting AZ78K0R

Confirm that "Connected" is displayed
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(3) Downloading a load module

Download the load module that has been linked with the RX78K0R in the debugger.

At this time, make sure that the message "RX Loaded" is displayed on the status bar (Load module status area) 

in the AZ78K0R window.

Figure 3-2  Downloading Load Module

(4) Switching the AZ trace mode

Click  in the AZ78K0R window to turn on AZ trace mode.

At this time, make sure that the message "AZ Trace ON" is displayed on the status bar (AZ trace mode status 

area) in the AZ78K0R window.

Figure 3-3  Switching AZ Trace Mode

(5) Execution of processing program

Run the processing program in the debugger; collection of trace data then starts.

(6) Stop of processing program

Stop execution of the processing program in the debugger. (If a breakpoint has been set, wait until the 

processing program breaks.)

Collection of trace data then ends.

(7) Loading of trace data

Confirm that "RX Loaded" is displayed

Confirm that "AZ Trace ON" is displayed
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Click  in the AZ78K0R window to load trace data collected by the simulator or in-circuit emulator.

(8) Verification in AZ:Analyze window

Click  in the AZ78K0R window to open the AZ:Analyze window.

In the AZ:Analyze window and windows opened via the the AZ:Analyze window, analysis related to time, such as 

bugs caused by processing timing and evaluation of entire system performance.

[Note] For how to read the execution transition map displayed in this window, refer to "How to read 

execution transition map" and "How to verify execution transition map".

Figure 3-4  Display Example of AZ:Analyze Window

(9) Verification in Pattern Search dialog box

Click  in the AZ:Analyze window to open the Pattern Search dialog box.

In this window, the point at which a specific event occurred can be searched for, based on the execution 

transition map displayed in the AZ:Analyze window.

[Note] For how to search for the point at which a specific event occurred, refer to "How to search".
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Figure 3-5  Display Example of Pattern Search Dialog Box

(10) Verification in AZ:Cpu window

Click  in the AZ:Analyze window to open the AZ:Cpu window.

In this window, the CPU usage in a section between the up cursor and down cursor in the AZ:Analyze window 

can be checked.

[Note] For how to count the CPU usage, refer to "How to search".

Figure 3-6  Display Example of AZ:Cpu Window

(11) Verification in AZ:Trace View window

Click  in the AZ:Analyze window to open the AZ:Trace View window.

In this window, information obtained from the execution transition map in the AZ:Analyze window can be viewed 

in list form.

[Note] For how to read the list displayed in this window, refer to "How to read the list".
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Figure 3-7  Display Example of AZ:Trace View Window

(12) Verification in Trace Search dialog box

Click the [View] menu -> [Find...] in the AZ:Trace View window to open the Trace Search dialog box.

In this window, specific information (trace data) can be searched for from the list displayed in the AZ:Trace View 

window.

[Note] For how to search for specific information (trace data), refer to "How to search".

Figure 3-8  Display Example of Trace Search Dialog Box
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CHAPTER 4  WINDOW REFERENCE

4. 1  Overview

The following shows the list of the AZ78K0R windows and dialog boxes.

Table 4-1  List of AZ78K0R Windows and Dialog Boxes

Window/Dialog Box Name Function

AZ78K0R window Central window for using the functions provided by the AZ78K0R

Open/Save As dialog box Specifies the file name when loading a file that contains information to be 

displayed in the AZ:Analyze window and AZ:Cpu window, or when saving 

information displayed in the AZ:Analyze window, AZ:Cpu window and 

AZ:Trace View window as a file.

AZ:Analyze window Displays information obtained from the trace data loaded into the 

AZ78K0R window, in the form of an execution transition map.

Pattern Search dialog box Searches for the point at which a specific event occurred, based on the 

execution transition map displayed in the AZ:Analyze window.

AZ:Cpu window Displays the CPU usage in a section between the up cursor and down 

cursor in the AZ:Analyze window.

AZ:Trace View window Lists information obtained from the execution transition map in the 

AZ:Analyze window.

Trace Search dialog box Searches for specific information (trace data) based on the list displayed in 

the AZ:Trace View window.

About dialog box Displays the version information of the AZ78K0R.

AZ:Error dialog box Displays the error information of the AZ78K0R.
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4. 2  Relationship of Windows and Dialog Boxes

The following shows the relationship of the windows and dialog boxes.

Figure 4-1  Relationship of Windows and Dialog Boxes

AZ:Trace View window

: Window

: Dialog box

Open/Save As dialog box

Trace Search dialog box

Open/Save As dialog box

AZ:Cpu window

Pattern Search dialog box

Open/Save As dialog box

AZ:Analyze window

AZ78K0R window

About dialog box
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4. 3  Explanation of Windows and Dialog Boxes

This section describes each window/dialog box of the AZ78K0R as follows:

Window/Dialog box name

Shown in the frame are the window or dialog box name.

In addition, the display image of the window or dialog box, functional outline, and how to open the window or dialog box 

are also explained.

Explanation of each area

Explains items to be set to or displayed in each area of the window or dialog box.

Menu bar

Lists the menu items and explains the operation of each menu item.

Tool bar

Explains the operation of each button on the tool bar.

Status bar

Explains the status bar in constituent units.

Function buttons

Explains the operation of each function button in the window or dialog box.

Caution

Enumerates points that require care during operation in the window or dialog box.

Other

Explains restored file information, how to read the execution transition map, how to verify the execution transition map, 

search methods, and counting methods.
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AZ78K0R window

This is the central window for using the functions provided by the AZ78K0R.

This window opens automatically when the AZ78K0R is started.

Figure 4-2  AZ78K0R Window

This section describes the following items:

- Menu bar

- Tool bar

- Status bar

- Caution

Menu bar

(1) File

Exit Terminates the AZ78K0R.

The function of this item is same as that of the  button.

Menu bar

Status bar

Tool bar
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(2) Option

(3) Operation

Tool Bar Switches displaying and hiding the tool bar (default: displayed).

Status Bar Switches displaying and hiding the status bar (default: displayed).

AZ Trace ON Turns on the AZ trace mode.

Trace data is collected into the trace buffer of the simulator/in-circuit emulator 

by running a processing program while the AZ trace mode is ON.

The function of this item is same as that of the  button.

AZ Trace OFF Turns off the AZ trace mode.

Trace data is not collected into the trace buffer of the simulator/in-circuit 

emulator if a processing program is executed while the AZ trace mode is OFF.

The function of this item is same as that of the  button.

Upload Loads trace data stored in the trace buffer.

The AZ trace mode is automatically turned off when loading of trace data is 

finished.

This menu is unavailable if trace data has not been collected.

The function of this item is same as that of the  button.
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(4) Browse

(5) Window

(6) Help

Analyze... Opens the AZ:Analyze window in Active mode.

If loading of trace data has been finished in this window, the execution 

transition map is displayed in the corresponding window.

The function of this item is same as that of the  button.

Close All Closes windows and dialog boxes other than this window.

This Window Displays the help widnow for this window.

Help Topics Opens the online help, with the [Search] tab displayed.

About... Opens the About dialog box.

The version information of the AZ78K0R is displayed.
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Tool bar

The tool bar consists of buttons that can execute frequently used menu items with a single action.

Table 4-2  Tool Bar Buttons (AZ78K0R Window)

Button Function

Switches the AZ trace mode.

Trace data is collected into the trace buffer of the simulator/in-circuit emulator by 

running a processing program while the AZ trace mode is ON.

Trace data is not collected into the trace buffer of the simulator/in-circuit emulator if a 

processing program is executed while the AZ trace mode is OFF.

Same operation an [Operation] menu -> [AZ Trace ON] or [Operation] menu -> [AZ 

Trace OFF].

Loads trace data stored in the trace buffer.

The AZ trace mode is automatically turned off when loading of trace data is finished.

This button is unavailable if trace data has not been collected.

Same operation an [Operation] menu -> [Upload].

Opens the AZ:Analyze window in Active mode.

If loading of trace data has been finished in this window, the execution transition map 

is displayed in the corresponding window.

Same operation an [Browse] menu -> [Analyze...].
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Status bar

The following explains areas in the status bar.

Figure 4-3  Status Bar (AZ78K0R Window)

(1) Connection status area

This area indicates the status of connection with the debugger.

(2) Load module status area

This area indicates the state of the load module to be loaded onto the debugger.

This area is not displayed if the AZ78K0R is not connected to the debugger.

(3) Load module execution status area

This area indicates the state of the application program execution.

This area is not displayed if the AZ78K0R is not connected to the debugger.

Connected Connected to the debugger.

Not Connected Not connected to the debugger.

RX Loaded A load module linked with the RX78K0R has been downloaded.

RX None No load modules linked with the RX78K0R have been downloaded.

Running Status of application program being execution.

Breaked Status of application program operation undergoing break.

(1) Connection status area

(2) Load module status area

(3) Load module execution status area

(4) AZ trace mode status area
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(4) AZ trace mode status area

This area indicates the current state of AZ trace mode.

This area is not displayed when the AZ78K0R is not connected with a debugger, or if no load modules linked with 

the RX78K0R have been downloaded.

Caution

- When switching the AZ trace mode to the ON state, a load module linked with the RX78K0R must already be 

downloaded to the debugger ([RX Loaded] is displayed in the status bar).

- Trace condition setting for the simulator or in-circuit emulator is performed when the AZ trace mode is switched to 

the ON state.

Refer to "3. 1 Trace Form" for details on trace conditions on the simulator/in-circuit emulator side, which are 

required for switching the AZ trace mode.

AZ Trace ON Status where AZ trace ON has been set.

AZ Trace OFF Status where AZ trace OFF has been set.
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Open/Save As dialog box

This dialog box is used to specify the file name when loading a file that contains information to be displayed in the 

AZ:Analyze window and AZ:Cpu window, or when saving information displayed in the AZ:Analyze window, AZ:Cpu 

window and AZ:Trace View window as a file.

This dialog box can be opened from the each window (AZ:Analyze window, AZ:Cpu window, AZ:Trace View window) by 

any of the following:

[When loading]

- Select the [File] menu -> [Open...].

- Click the  button on the tool bar.

- Press the [Alt], [F] and [O] keys in that order.

- Press the [Ctrl] + [O] keys at the same time.

[When saving]

- Select the [File] menu -> [Save...].

- Click the  button on the tool bar.

- Press the [Alt], [F] and [S] keys in that order.

- Press the [Ctrl] + [S] keys at the same time.
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Figure 4-4  Open/Save As Dialog Box (When Loading)

(1) File location area

(2) File list area

(3) File name area

(4) File type area
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Figure 4-5  Open/Save As Dialog Box (When Saving)

This section describes the following items:

- Explanation of each area

- Function buttons

- Restored file information

Explanation of each area

(1) File location area

This area is used to select the folder where a target file is stored or is to be stored.

(2) File list area

This area lists the files that match the conditions selected in the file location area and file type area.

(3) File name area

This area is used to specify the name of a target file.

(1) File location area

(2) File list area

(3) File name area

(4) File type area
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(4) File type area

This area is used to select the type of files to be displayed in the file list area.

The default type displayed in this area varies depending on the window from which the file is called, as shown 

below.

Function buttons

Restored file information

Handling of files loaded in this dialog box varies depending on the window from which the file is called, as shown below.

- AZ:Analyze window

Information of the file loaded into the AZ:Analyze window, which called the file, will be restored. To maintain the 

previous information, switch to the Hold mode the AZ:Analyze window that has information to be maintained, open 

another AZ:Analyze window, and then load the file from the window in the Hold mode.

- AZ:Cpu window

A new AZ:Cpu window opens, and information of the file loaded into the window is restored. The AZ:Cpu window 

that called the file therefore maintains the previous information.

Window Name File of Type

AZ:Analyze window Binary (.az)

AZ:Cpu window CSV (.azc)

AZ:Trace View window CSV (.azt)

Button Function

Open/Save Loads the file that matches the conditions specified in this dialog box.

Saves the information displayed in the window into the file that matches the 

conditions specified in this dialog box.

Cancel Closes this dialog box.

Help Displays the help widnow for this dialog box.
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AZ:Analyze window

This window displays information obtained from the trace data loaded into the AZ78K0R window, in the form of an 

execution transition map.

This dialog box can be opened from the AZ78K0R window by any of the following:

- Select the [Browse] menu -> [Analyze...].

- Click the  button on the tool bar.

- Press the [Alt], [B] and [A] keys in that order.

- Press the [Ctrl] + [A] keys at the same time.
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Figure 4-6  AZ:Analyze Window

(11) Down cursor

(5) Trace time

(14) Pop-up area

(17) Jump to end button(16) Jump to beginning button

(12) Simple search buttons

(7) Object buttons

(8) Display scale change area

(10) Up temporary cursor

(4) Time up to the point subject to manipulation

(9) Up cursor

(1) Time up to count start point

(2) Time up to count end point

(3) Total time

(6) Sort buttons

(13) Execution transition map

(15) Time area
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This section describes the following items:

- Explanation of each area

- Menu bar

- Tool bar

- How to read execution transition map

- How to verify execution transition map

Explanation of each area

(1) Time up to count start point

This area displays the time up to the CPU usage counting start point.

The time up to the count start point is a relative time from when trace processing starts until the execution 

reaches the up cursor position (unit: msec).

(2) Time up to count end point

This area displays the time up to the CPU usage counting end point.

The time up to the count end point is a relative time from when trace processing starts until the execution reaches 

the down cursor position (unit: msec).

(3) Total time

This area displays the total time of the CPU usage.

The total time is a relative time indicated from the up cursor position to the down cursor position (unit: msec).

(4) Time up to the point subject to manipulation

This area displays the times up to when various types of manipulation (such as opening of the Source window, 

Assemble window or Memory window, and execution of simple search) are performed.

The time up to the point subject to manipulation is an absolute time from when trace processing starts until the 

execution reaches the up temporary cursor (unit: msec).

(5) Trace time

The trace time is a relative time from the start to the end of trace processing (unit: msec).

(6) Sort buttons

This button is used to change the object button display order.

This area consists of the following buttons.

Table 4-3  Sort Buttons in AZ:Analyze Window

Button Function

Appr Displays trace data in the order of detection (default).
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(7) Object buttons

These buttons display the objects (interrupt handlers, tasks, idle routines, eventflags, semaphores, mailboxes, or 

fixed-sized memory pools) detected as trace data.

For details on the object button display format, refer to " Object button display format".

(8) Display scale change area

This area is used to change the display scale of the execution transition map.

The drop-down list consists of the following items.

Table 4-4  Display Scale of Execution Transition Map

(9) Up cursor

This cursor specifies the point from which the CPU usage is counted.

This cursor can be moved by clicking it with the SHIFT key being pressed in the execution transition map.

(10) Up temporary cursor

This cursor specifies the point from which a manipulation (such as opening of the Source window, Assemble 

window or Memory window, and execution of simple search) is performed.

This cursor can be moved by dragging it with the SHIFT key being pressed in the execution transition map.

[Note] When the up cursor is moved, the up temporary cursor also moves to the same position.

(11) Down cursor

This cursor specifies the point at which counting of the CPU usage ends.

This cursor can be moved by clicking it with the CTRL key being pressed in the execution transition map.

Name Displays the objects in the order of ASCII code.

ID Displays the objects in the ID order.

Pri Displays the objects in the priority order (valid for tasks only).

Item Meaning

x 2 Magnifies the execution transition map by 2.

x 1/2 Shrinks the execution transition map to 1/2.

Button Function
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(12) Simple search buttons

These buttons are displayed when an object button is clicked, and used to perform the following manipulations.

These buttons are hidden when the object button is clicked again.

Table 4-5  Simple Search Buttons in AZ:Analyze Window

(13) Execution transition map

This area displays the processing program analysis result.

Refer to "How to read execution transition map" for details on marks shown in the execution transition map.

[Note] If the number of OS resources subject to display exceeds 1,000, this area may not be displayed 

correctly.

(14) Pop-up area

The following information related to the position pointed to by the mouse pointer pops up.

Table 4-6  Details of Information in AZ:Analyze Window

Button Function

Searches for the point at which an event related to the relevant object 

occurred, from the search start point toward the reverse direction to the 

time axis.

The up temporary cursor shows the detected point.

A beep is generated if no events have occurred at any location.

Searches for the point at which an event related to the relevant object 

occurred, from the search start point toward the time axis direction.

The up temporary cursor shows the detected point.

A beep is generated if no events have occurred at any location.

Mouse Pointer Meaning

Object button Object name

Black vertical line The following information related to processing program switching

- Time taken to generate processing program switching (unit: 

msec)

- Name of processing program before switching

- Name of processing program after switching
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[Note] Nothing pops up on light-blue horizontal lines.

(15) Time area

This area displays the guide for generation interval of events displayed in the execution transition map.

The display unit is shown at the right end of this area.

[Note] In Equal mode, this area displays the guide for the number of events displayed in the execution 

transition map.

(16) Jump to beginning button

This button moves the up cursor to the top of trace data.

Orange horizontal line The following information related to service calls

- Time taken to issue a service call (unit: msec)

- Time taken to return from a service call (unit: msec)

- Service call processing time (unit: msec)

- Service call name

- Name of object subject to manipulation by service call

Orange horizontal line The following information related to interrupts

- Time taken to generate an interrupt (unit: msec)

- Time taken to finish interrupt handler processing (unit: msec)

- Interrupt handler processing time (unit: msec)

Blue triangle The following information related to interrupts

- Time taken to generate an interrupt (unit: msec)

Blue inverted triangle The following information related to interrupts

- Time taken to finish interrupt handler processing (unit: msec)

Light-blue/green line

 / 

The following information related to object access status

- Time taken to issue a service call (unit: msec)

- Time taken to return from a service call (unit: msec)

- Name of processing program that issued a service call

- Service call name

- Name of object subject to manipulation by service call

Red x-mark The following information related to service calls

- Time taken to return from a service call (unit: msec)

- Value returned from service call

Mouse Pointer Meaning
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(17) Jump to end button

This button moves the down cursor to the end of trace data.

Menu bar

(1) File

(2) View

Open... Opens the Open/Save As dialog box.

Loads the file that contains information to be displayed in this window 

(extension: .az).

The function of this item is same as that of the  button.

Save... Opens the Open/Save As dialog box.

Specifies the name of the file into which information displayed in this window 

is saved (extension: .az).

The function of this item is same as that of the  button.

Close Closes this widnow.

Grid mode Specifies whether to display gridlines in the execution transition map.



CHAPTER 4    WINDOW REFERENCE

46 User’s Manual    U18802EJ1V0UM

(3) Operation

Grid Displays gridlines (default).

Ungrid Does not display gridlines.

View mode Specifies the execution transition map display mode.

Simple Displays the execution transition map in Simple mode.

The function of this item is same as that of the  button.

Standard Displays the execution transition map in Standard mode.

The function of this item is same as that of the  button.

Detail Displays the execution transition map in Detailed mode (default).

The function of this item is same as that of the  button.

Equal Displays the execution transition map in Equal mode.

The function of this item is same as that of the  button.

Small hrinks the execution transition map display to 1/2.

The effect is the same as selecting "x 1/2" in the display scale change area.

Large Magnifies the execution transition map display by 2.

The effect is the same as selecting "x 2" in the display scale change area.

Find... Opens the Pattern Search dialog box.

Searches for the point at which a specific event occurred, based on the 

execution transition map displayed in this window.

The function of this item is same as that of the  button.

Sort Object Specifies the object button display order.

Appear Displays trace data in the order of detection (default)

Name Displays the objects in the order of ASCII code

ID Displays the objects in the ID order

Priority Displays the objects in the priority order (valid for tasks only)

Active Switches this window to the Active mode.

This window is in the Active mode when opened. This window opens 

automatically when the AZ78K0R is started.

Hold Switches this window to the Hold mode.
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(4) Browse

(5) Jump

CPU... Opens the AZ:Cpu window in Active mode.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the AZ:Cpu window has already been opened in the Active mode, 

information displayed in the window is updated.

The function of this item is same as that of the  button.

Trace View... Opens the AZ:Trace View window in Active mode.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the AZ:Trace View window has already been opened in the Active mode, 

information displayed in the window is updated.

The function of this item is same as that of the  button.

Source Text... Opens the Source window of the debugger.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the Source window has already been opened in the Active mode, 

information displayed in the window is updated.

The function of this item is same as that of the  button.

Assemble... Opens the Assemble window of the debugger.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the Assemble window has already been opened in the Active mode, 

information displayed in the window is updated.

The function of this item is same as that of the  button.
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[Note] If there is no address information at the position pointed to by the up temporary cursor, items in the 

Jump menu are not available.

(6) Help

Tool bar

The tool bar consists of buttons that can execute frequently used menu items with a single action.

Table 4-7  Tool Bar Buttons (AZ:Analyze Window)

Memory... Opens the Memory window of the debugger.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the Memory window has already been opened in the Active mode, 

information displayed in the window is updated.

The function of this item is same as that of the  button.

This Window Displays the help widnow for this window.

Help Topics Opens the online help, with the [Search] tab displayed.

Button Function

Opens the Open/Save As dialog box.

Loads the file that contains information to be displayed in this window (extension: 

.az).

Same operation an [File] menu -> [Open...].

Opens the Open/Save As dialog box.

Specifies the name of the file into which information displayed in this window is 

saved (extension: .az).

Same operation an [File] menu -> [Save...].

Specifies whether to display gridlines in the execution transition map (default: 

Displays gridlines).

Displays the execution transition map in Simple mode.

Same operation an [View] menu -> [View mode] -> [Simple].

Displays the execution transition map in Standard mode

Same operation an [View] menu -> [View mode] -> [Standard].
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Displays the execution transition map in Detailed mode (default).

Same operation an [View] menu -> [View mode] -> [Detail].

Displays the execution transition map in Equal mode.

Same operation an [View] menu -> [View mode] -> [Equal].

Opens the Pattern Search dialog box.

Searches for the point at which a specific event occurred, based on the execution 

transition map displayed in this window.

Same operation an [View] menu -> [Find...].

Opens the AZ:Cpu window in Active mode.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the AZ:Cpu window has already been opened in the Active mode, information 

displayed in the window is updated.

Same operation an [Browse] menu -> [CPU...].

Opens the AZ:Trace View window in Active mode.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the AZ:Trace View window has already been opened in the Active mode, 

information displayed in the window is updated.

Same operation an [Browse] menu -> [Trace View...].

Opens the Source window of the debugger.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the Source window has already been opened in the Active mode, information 

displayed in the window is updated.

Same operation an [Jump] menu -> [Source Text...].

Opens the Assemble window of the debugger.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the Assemble window has already been opened in the Active mode, information 

displayed in the window is updated.

Same operation an [Jump] menu -> [Assemble...].

Opens the Memory window of the debugger.

Information later than the position pointed to by the up temporary cursor in the 

execution transition map is displayed in the window.

If the Memory window has already been opened in the Active mode, information 

displayed in the window is updated.

Same operation an [Jump] menu -> [Memory...].

Button Function
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Object button display format

Object buttons are displayed as explained below.

A too-long object name is abbreviated, but its real name pops up if the relevant button is pointed to by the mouse 

pointer.

(1) Object button display order

The object button display order can be changed by clicking a sort button, or by dragging the corresponding object 

button.

(2) Hiding object buttons

Object buttons can be hidden by right-clicking the button corresponding to the object.

Button Meaning

Interrupt Interrupt handler

The button name is fixed to "Interrupt".

Task name Task

Task name defined in system configuration file

Tsk (????) Unknown processing program

If execution of starts in the middle of a processing program, the AZ78K0R cannot 

identify whether the processing program is an interrupt handler, task, or idle routine. 

The AZ78K0R therefore handles the processing program as an unknown processing 

program.

Idle Idle routine

The button name is fixed to "Idle"

Eventflag name Eventflag

Eventflag name defined in system configuration file

Semaphore name Semaphore

Semaphore name defined in system configuration file

Mailbox name Mailbox

Mailbox name defined in system configuration file

Fixed-sized memory pool 

name

Fixed-sized memory pool

Fixed-sized memory pool name defined in system configuration file

Etc. Object hidden by right-clicking the object button
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How to read execution transition map

The three types of basic display modes: Simple mode, Standard mode and Detailed mode, are available for displaying 

the execution transition map. In addition to them, the Equal mode can be specified for each basic mode.

These modes can be selected by selecting the [View] menu -> [View mode].

(1) Simple mode

Displays the CPU usage with horizontal lines.

Figure 4-7  AZ:Analyze Window (Simple Mode)

Table 4-8  Marks Displayed in AZ:Analyze Window (Simple Mode)

Mark Meaning

Brown horizontal line Task or idle routine

Orange horizontal line Interrupt handler or RX78K0R internal processing

Blue triangle Start of interrupt handler processing

Blue inverted triangle End of interrupt handler processing
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(2) Standard mode

Displays the processing program switching status, with vertical lines being combined with information displayed 

in the Simple mode.

Figure 4-8  AZ:Analyze Window (Standard Mode)

Table 4-9  Marks Displayed in AZ:Analyze Window (Standard Mode)

Mark Meaning

Brown horizontal line Task or idle routine

Orange horizontal line Interrupt handler or RX78K0R internal processing

Blue triangle Start of interrupt handler processing

Blue inverted triangle End of interrupt handler processing

Black vertical line Processing program switching status
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(3) Detailed mode

Displays the service call issuance status, in addition to information displayed in the Standard mode.

Figure 4-9  AZ:Analyze Window (Detailed Mode)

Table 4-10  Marks Displayed in AZ:Analyze Window (Detailed mode)

Mark Meaning

Brown horizontal line Task or idle routine

Orange horizontal line Interrupt handler or RX78K0R internal processing

Blue triangle Start of interrupt handler processing

Blue inverted triangle End of interrupt handler processing

Black vertical line Processing program switching status

Light-blue line [If a semaphore is subject to manipulation]

Issuance of wai_sem, pol_sem or twai_sem

[If an eventflag is subject to manipulation]

Issuance of wai_flg, pol_flg or twai_flg

[If a mailbox is subject to manipulation]

Issuance of rcv_mbx, prcv_mbx or trcv_mbx

[If a fixed-sized memory pool is subject to manipulation]

Issuance of get_mpf, pget_mpf or tget_mpf
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[Note] If a service call that moves to the WAITING state is issued in an unknown processing program, "Tsk 

(????)", the AZ78K0R cannot recognize the WAITING state being released. The light-blue horizontal 

lines will therefore be drawn up to the end of the trace data counting.

Green line [If a semaphore is subject to manipulation]

Issuance of sig_sem or Isig_sem

[If an eventflag is subject to manipulation]

Issuance of set_flg or iset_flg/clr_flg

[If a mailbox is subject to manipulation]

Issuance of snd_mbx

[If a fixed-sized memory pool is subject to manipulation]

Issuance of rel_mpf

Red x-mark A service call abnormally ended

Timeout mark A service call timed out

Mark Meaning
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(4) Equal mode

In the default state (in which the Equal mode is not specified), the brown/orange horizontal lines that show the 

CPU usage are displayed in proportion to the execution time taken by each processing program (see Figure 4-

10).

Figure 4-10  AZ:Analyze Window (When Equal Mode Is Not Specified)

In the state in which the Equal mode is specified, in contrast, the brown/orange horizontal lines that show the 

CPU usage are displayed with a fixed length (see Figure 4-11).

The horizontal lines between events such as task switching are also displayed in a fixed interval, not proportional 

to the CPU processing time.

Figure 4-11  AZ:Analyze Window (When Equal Mode Is Specified)

Displayed in proportion to the execution time

Displayed with a fixed length
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How to verify execution transition map

The execution transition map displayed in this window can be verified using either of the following two methods.

(1) Search using simple search buttons

The simple search buttons ( ) can be used for searching for the location where an event related to the 

specified object occurred.

The following explains the procedure for searching event occurrence location, by using simple search buttons.

(a) Specification of search start point

Move the up temporary cursor to the search start point.

If the up temporary cursor is not displayed, move the up cursor to the search start point.

(b) Displaying simple search buttons

Click the object button corresponding to the object subject to search, to display the simple search buttons.

(c) Clicking simple search buttons

- When the  is clicked

The point at which an event related to the object selected in (b) occurred is searched for, from the 

search start point toward the reverse direction to the time axis, and the detected point is shown by the 

up temporary cursor.

A beep is generated if no events have occurred at any location.

- When the  is clicked

The point at which an event related to the object selected in (b) occurred is searched for, from the 

search start point toward the time axis direction, and the detected point is shown by the up temporary 

cursor.

A beep is generated if no events have occurred at any location.

(2) Searching in Pattern Search dialog box

The point at which a specific event occurred can be searched for in the Pattern Search dialog box.

Refer to "How to search" for searching for the point at which a specific event occurred, in the Pattern Search 

dialog box.
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Pattern Search dialog box

This dialog box is used to search for the point at which a specific event occurred, based on the execution transition map 

displayed in the AZ:Analyze window.

This dialog box can be opened from the AZ:Analyze window by any of the following:

- Select the [View] menu -> [Find...].

- Click the  button on the tool bar.

- Press the [Alt], [V] and [F] keys in that order.

- Press the [Ctrl] + [F] keys at the same time.

Figure 4-12  Pattern Search Dialog Box

This section describes the following items:

- Explanation of each area

- Function buttons

- How to search

(1) [Search Mode] area

(2) [Task Switch] area
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Explanation of each area

(1) [Search Mode] area

This area is used to select events to be searched for (types of events to be searched for from the execution 

transition map displayed in the AZ:Analyze window).

The following items can be selected as the events to be searched for.

Table 4-11  Types of Searched Events

(2) [Task Switch] area

This area is used to select the conditions for searching for the events selected in the Search Mode area.

The items displayed in this area vary depending on the selection in the Search Mode area.

Table 4-12  Search Conditions (When Task Switch Is Selected)

[Note] The search target varies depending on which of the items, [Valid] and [Invalid], is selected in the 

Interrupt list, as shown below.

The following figure assumes that switching from a "processing program [* ANY *]" to "processing 

program [Task2]" is included into the search targets.

Searched Event Name Meaning

Task Switch Switching of processing programs

Service Call (Call) Issuance of service call

Service Call (Return) Returning from a service call routine

Service Call (Error) Errors returned from a service call

Item Meaning

Task (upper) Select a processing program before switching.

Select [name of the target task] for task switching, [Interrupt] for 

interrupt handler switching, or [* ANY *] for any processing program 

switching.

Task (lower) Select a processing program after switching.

Select [name of the target task] for task switching, [Interrupt] for 

interrupt handler switching, or [* ANY *] for any processing program 

switching.

Interrupt If [* ANY *] is selected for Task (upper) or Task (lower), select whether 

to include the location where switching to/from an interrupt handler 

occurred, into the search targets.

Select [Valid] to include the location, or [Invalid] not to include the 

location.
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Figure 4-13  Difference in Search Targets

- Switching point (a)

- Switching point (b)

- Switching point (c)

Table 4-13  Search Conditions (When a Service Call (Call, Return, Error) Is Selected)

Valid Switching from [Task1] to [Task2] is included into the search targets.

Invalid Switching from [Task1] to [Task2] is included into the search targets.

Valid Switching from [Interrupt] to [Task2] is included into the search targets.

Invalid Switching from [Interrupt] to [Task2] is ignored, and switching from 

[Task1] to [Task2] is included into the search targets.

Valid Switching from [Interrupt] to [Task2] is included into the search targets.

Invalid Switching from [Interrupt] to [Task2] is ignored, and switching from 

[Task1] to [Task2] is included into the search targets.

Item Meaning

Task Select the processing program that issued the service call.

Select [name of the target task] for task switching, [Interrupt] for 

interrupt handler switching, or [* ANY *] for any processing program 

switching.

Service Call Select the service call name.

Select [* ANY *] for any service call.

Object Select the name of an object subject to manipulation by the service 

call.

Select [* ANY *] for any object.

Interrupt

Task1

Task2
(b) (c)

Invalid

(a)

Valid



CHAPTER 4    WINDOW REFERENCE

60 User’s Manual    U18802EJ1V0UM

Function buttons

How to search

Using the following procedure, the point at which a specific event occurred to be searched for, based on the execution 

transition map displayed in the AZ:Analyze window.

(1) Specification of search start point

Move the up temporary cursor to the search start point in the AZ:Analyze window.

If the up temporary cursor is not displayed, move the up cursor to the search start point.

(2) 本 How to open this dialog box

Select the [View] menu -> [Find...] in the AZ:Analyze window.

(3) Selection of events to be searched for and search conditions

Select the events to be searched for and search conditions in the Search Mode and Task Switch areas in this 

dialog box.

(4) Clicking function buttons

- When the [Search (Fore)] button is clicked

Points that match the conditions selected in this dialog box are searched for from the search start point 

toward the time axis direction, the up temporary cursor in the AZ:Analyze window shows the locations that 

match the specified conditions.

A beep is generated if no locations match the specified conditions

- When the [Search (Back)] button is clicked

Points that match the conditions selected in this dialog box are searched for from the search start point 

toward the reverse direction to the time axis. The up temporary cursor in the AZ:Analyze window shows the 

Button Function

Search (Fore) Searches for the locations that match the conditions selected in this dialog box, from 

the search start point toward the time axis direction.

The up temporary cursor in the AZ:Analyze window shows the locations that match 

the specified conditions.

A beep is generated if no locations match the specified conditions.

Search (Back) Searches for the locations that match the conditions selected in this dialog box, from 

the search start point toward the reverse direction to the time axis.

The up temporary cursor in the AZ:Analyze window shows the locations that match 

the specified conditions.

A beep is generated if no locations match the specified conditions.

Close Closes this dialog box.

Help Displays the help widnow for this dialog box.
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locations that match the specified conditions.

A beep is generated if no locations match the specified conditions.
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AZ:Cpu window

This window displays the CPU usage in a section between the up cursor and down cursor in the AZ:Analyze window.

This window can be opened from the AZ:Analyze window by any of the following:

- Select the [Browse] menu -> [CPU...].

- Click the  button on the tool bar.

- Press the [Alt], [B] and [C] keys in that order.

- Press the [Ctrl] + [C] keys at the same time.

[Note] This window is closed in conjunction with closing the AZ:Analyze window that called the file.

Figure 4-14  AZ:Cpu Window

(1) Time up to count start point

(2) Time up to count end point

(3) Total time

(8) System processing code coverage

(5) Total execution time of processing program

(7) User processing code coverage

(4) Processing program name

(6) CPU usage

(3) Total time
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This section describes the following items:

-  Explanation of each area

-  Menu bar

-  Tool bar

-  Count method

Explanation of each area

(1) Time up to count start point

This area displays the time up to the CPU usage counting start point.

The time up to the count start point is a relative time from when trace processing starts until the execution 

reaches the up cursor position (unit: msec).

(2) Time up to count end point

This area displays the time up to the CPU usage counting end point.

The time up to the count end point is a relative time from when trace processing starts until the execution reaches 

the down cursor position (unit: msec).

(3) Total time

This area displays the total time of the CPU usage.

The total time is a relative time indicated from the up cursor position to the down cursor position (unit: msec).

(4) Processing program name

This area lists the processing programs executed within the total time.

The following types of processing programs are displayed.

Table 4-14  Processing Program Types

(5) Total execution time of processing program

This area displays the total execution time of the processing program within the total time (unit: msec).

Processing Program Name Meaning

Task name Task

Interrupt Interrupt handler

Idle Idle routine
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(6) CPU usage

This area displays the bar graphs for indicating the percentage of the total time occupied by the execution time of 

processing programs.

The bar graphs distinguish user processing and system processing with different colors.

Table 4-15  Colors in Bar Graph

[Note] Service calls issued in a task or interrupt handler are handled as RX78K0R internal processing.

(7) User processing code coverage

This area displays the percentage of the total time occupied by the user processing execution time.

(8) System processing code coverage

This area displays the percentage of the total time occupied by the system processing execution time.

Menu bar

(1) File

Color Meaning

Brown User processing (task, idle routine)

Orange System processing (interrupt handler or RX78K0R internal processing)

Open... Opens the Open/Save As dialog box.

Loads the file that contains information to be displayed in this window 

(extension: .azc).

The function of this item is same as that of the  button.

Save... Opens the Open/Save As dialog box.

Specifies the name of the file into which information displayed in this window 

is saved (extension: .azc).

The function of this item is same as that of the  button.

Close Closes this window.
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(2) View

(3) Operation

(4) Help

Sort Appear Displays the bar graphs in the order of detection in trace data.

The function of this item is same as that of the  button.

Sort Name Displays the bar graphs in the alphabetical order of the processing program 

names.

The function of this item is same as that of the  button.

Sort Time Displays the bar graphs in the order of longer total execution time (default).

The function of this item is same as that of the  button.

Sort Analyze Displays the bar graphs in the same order as those displayed in the execution 

transition map.

The function of this item is same as that of the  button.

Active Switches this window to the Active mode.

This window is in the Active mode when opened.

Hold Switches this window to the Hold mode.

This Window Displays the help widnow for this window.
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Tool bar

The tool bar consists of buttons that can execute frequently used menu items with a single action.

Table 4-16  Tool Bar Buttons (AZ:Cpu Window)

Count method

Using the following procedure, the CPU usage in a section between the up cursor and down cursor in the AZ:Analyze 

window can be checked.

(1) Specification of count start point

Move the up cursor to the count start position in the AZ:Analyze window.

(2) Specification of count end point

Move the down cursor to the count end position in the AZ:Analyze window.

(3) How to open this window

Select the [Browse] menu -> [CPU...] in the AZ:Analyze window.

When this window is opened, information corresponding to the count section specified in (1) and (2) is displayed.

[Note] When this window is in the Active mode, information displayed in this window is also updated 

Help Topics Opens the online help, with the [Search] tab displayed.

Button Function

Opens the Open/Save As dialog box.

Loads the file that contains information to be displayed in this window (extension: 

.azc).

Same operation an [File] menu -> [Open...].

Opens the Open/Save As dialog box.

Specifies the name of the file into which information displayed in this window is 

saved (extension: .azc).

Same operation an [File] menu -> [Save...].

Displays the bar graphs in the order of detection in trace data.

Same operation an [View] menu -> [Sort Appear].

Displays the bar graphs in the alphabetical order of the processing program names.

Same operation an [View] menu -> [Sort Name].

Displays the bar graphs in the order of longer total execution time (default).

Same operation an [View] menu -> [Sort Time].

Displays the bar graphs in the same order as those displayed in the execution 

transition map.

Same operation an [View] menu -> [Sort Analyze].
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automatically along with moving of the up/down cursor in the AZ:Analyze window and information 

corresponding to the move destination of the up/down cursor is displayed.
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AZ:Trace View window

This window displays information obtained from the execution transition map in the AZ:Analyze window in list form.

This window can be opened from the AZ:Analyze window by any of the following:

- Select the [Browse] menu -> [Trace View...].

- Click the  button on the tool bar.

- Press the [Alt], [B] and [T] keys in that order.

- Press the [Ctrl] + [T] keys at the same time.

[Note] This window is closed in conjunction with closing the AZ:Analyze window that called the file.

Figure 4-15  AZ:Trace View Window

(1) [Time] area

(5) [Parameter] area

(2) [Address] area

(3) [Task] area

(4) [Event] area

(6) [Return] area
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This section describes the following items:

- Explanation of each area

- Menu bar

- How to display

- How to read the list

- Caution

Explanation of each area

(1) [Time] area

This area shows a relative time from when trace processing starts until the target event occurs (unit: msec).

(2) [Address] area

This area shows the execution address at which the target event occurred.

(3) [Task] area

This area shows the name of the processing program in which the target event occurred.

The following types of processing programs are displayed.

Table 4-17  Processing Program Types

(4) [Event] area

This area shows the types of the target events.

The following types of events are displayed.

Table 4-18  Event Types

Processing Program Name Meaning

Task name Issuance of service call, returning from a service call routine, start 

of task processing

Interrupt Issuance of service call, returning from a service call routine, start 

of interrupt handler processing, end of interrupt handler 

processing

Idle Start of idle routine processing

Event Name Meaning

ServCall (xxx_xxx) Issuance of service call

A service call name is displayed inside the parentheses.
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(5) [Parameter] area

If the event type is "ServCall (xxx_xxx)" or "ServRet (xxx_xxx)", this area displays the name of the object to be 

manipulated by the service call (such as task name, semaphore name, or eventflag name).

(6) [Return] area

If the event type is "ServRet (xxx_xxx)", this area displays the values returned from the service call.

Menu bar

(1) File

(2) View

ServRet (xxx_xxx) Returning from a service call routine

A service call name is displayed inside the parentheses.

The inside of the parentheses is left blank if the event that issued 

the service call does not exist in the trace buffer.

Int Start of interrupt handler processing

IntRet End of interrupt handler processing

TaskStart Start of task processing

Idle Start of idle routine processing

Save... Opens the Open/Save As dialog box.

Specifies the name of the file into which information displayed in this window 

is saved (extension: .azt).

Close Closes this window.

Event Name Meaning
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(3) Operation

(4) Help

Find... Opens the Trace Search dialog box.

Searches for specific information (trace data) based on the list displayed in 

this window.

This menu is unavailable when this window is in the Hold mode.

Timetag Selects [Show] or [Hide] of the Time area (default: Show).

Address Selects [Show] or [Hide] of the Address area (default: Show).

Task Selects [Show] or [Hide] of the Task area (default: Show).

Event Selects [Show] or [Hide] of the Event area (default: Show).

Parameter Selects [Show] or [Hide] of the Parameter area (default: Show).

Return Selects [Show] or [Hide] of the Return area (default: Show).

Active Switches this window to the Active mode.

This window is in the Active mode when opened.

Hold Switches this window to the Hold mode.

This Window Displays the help widnow for this window.

Help Topics Opens the online help, with the [Search] tab displayed.
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How to display

Using the following procedure, information obtained from the execution transition map displayed in the AZ:Analyze 

window can be listed.

(1) Specification of display start position

Move the up temporary cursor to the display start position in the AZ:Analyze window.

If the up temporary cursor is not displayed, the display start position is the top of the trace data.

(2) How to open this window

Select the [Browse] menu -> [Trace View...] in the AZ:Analyze window.

When this window is opened, information corresponding to the display start point specified in (1) is displayed in 

the first line.

[Note] When this window is in the Active mode, information displayed in this window is also updated 

automatically along with moving of the up/down cursor in the AZ:Analyze window, and information 

corresponding to the move destination of the up/down cursor is displayed in the first line.

How to read the list

The following explains how to read the list displayed in this window, using Figure 4-16 as an example.

Figure 4-16  How to Read the List

(1) When 156.273 msec have elapsed after trace processing has started, processing program TSK_MAIN issues 

service call rel_mpf to fixed-sized memory pool MPF_WORK1.

(2)  When 156.947 msec have elapsed after trace processing has started, service call rel_mpf that was issued in (1) 

returns E_OK.

The execution address in the above (1) and (2) means the address at which the relevant service call was issued.

(1)
(2)
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Caution

- If an interrupt occurs during idle routine processing, information related to "IntRet", which indicates the end of the 

interrupt handler processing, will not be displayed.
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Trace Search dialog box

This dialog box is used to search for specific information (trace data) based on the list displayed in the AZ:Trace View 

window.

This dialog box can be opened from the AZ:Trace View window by any of the following:

- Select the [View] menu -> [Find...].

- Press the [Alt], [V] and [F] keys in that order.

- Press the [Ctrl] + [F] keys at the same time.

Figure 4-17  Trace Search Dialog Box

This section describes the following items:

- Explanation of each area

- Function buttons

- How to search

(2) Search condition area

(1) Searched item area



CHAPTER 4    WINDOW REFERENCE

User’s Manual    U18802EJ1V0UM 75

Explanation of each area

(1) Searched item area

This area is used to specify the items to be searched for (from the list displayed in the AZ:Trace View window).

Multiple items in the following table can be selected as the items to be searched for.

Table 4-19  Search Item Types

(2) Search condition area

This area is used to select the conditions for searching for items specified in the searched item area.

The following items can be selected as the search conditions.

- Processing program name (task name, Interrupt, Idle)

- Event type (service call name)

- Name of object subject to manipulation by service call such as task name, semaphore name, or eventflag 

name)

Function buttons

Search Item Name Meaning

Task Searches for information from the Task area in the list displayed in the 

AZ:Trace View window.

Event Searches for information from the Event area in the list displayed in the 

AZ:Trace View window.

Parameter Searches for information from the Parameter area in the list displayed 

in the AZ:Trace View window

Button Function

Search (Fore) Searches for information that matches the conditions specified in this dialog box, 

from the older trace data.

Condition match information is displayed in the first line of the AZ:Trace View 

window.

A beep is generated if condition match information does not exist in the relevant list.

Search (Back) Searches for information that matches the conditions specified in this dialog box, 

from the newer trace data.

Condition match information is displayed in the first line of the AZ:Trace View 

window.

A beep is generated if condition match information does not exist in the relevant list.

Cancel Closes this dialog box.

Help Displays the help widnow for this dialog box.
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How to search

Using the following procedure, specific information can be searched for, based on the list displayed in the AZ:Trace 

View window.

(1) Switching to Active mode

Select the [Operation] menu -> [Active] in the AZ:Trace View window to switch the target window to the Active 

mode.

(2) How to open this dialog box

Select the [View] menu -> [Find...] in the AZ:Trace View window.

(3) Specification of items to be searched for and search conditions

Specify the items to be searched for and search conditions in the searched item area and search condition area 

in this dialog box.

Figure 4-18  Specification Example 1 (Search for Interrupt)

Figure 4-19  Specification Example 2 (Search for Location at Which sta_tsk Was Issued)
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Figure 4-20  Specification Example 3 (Search for Location at Which Service Call Was Issued for TSK_INIT)

(4) Clicking function buttons

- [Search (Fore)] button

Information that matches the conditions specified in this dialog box is searched for from the newer trace 

data, and condition match information is displayed in the first line of the AZ:Trace View window.

A beep is generated if condition match information does not exist.

- [Search (Back)] button

Information that matches the conditions specified in this dialog box is searched for from the newer trace 

data, and condition match information is displayed in the first line of the AZ:Trace View window.

A beep is generated if condition match information does not exist.
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About dialog box

This dialog box is used to display the version information of the AZ78K0R.

This dialog box can be opened from the AZ78K0R window by any of the following:

- Select the [Help] menu -> [About...].

- Press the [Alt], [H] and [A] keys in that order.

Figure 4-21  About dialog box

This section describes the following items:

- Explanation of each area

- Function buttons

Explanation of each area

(1) Version information area

This area is used to display "product name, version number, date of product build and copyright".

Function buttons

Button Function

OK Closes this dialog box.

(1) Version information area
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AZ:Error dialog box

This dialog box is used to display the error information of the AZ78K0R.

This dialog box opens automatically when an invalid operation is performed in a window or a dialog box.

Figure 4-22  AZ:Error Dialog Box

This section describes the following items:

- Explanation of each area

- Function buttons

Explanation of each area

(1) Error information area

This area is used to display "error number and error message".

For details of the error information, see "CHAPTER 5  ERROR INFORMATION".

Function buttons

Button Function

OK Closes this dialog box.

Help Displays the help topic corresponding to error information.

(1)  Error information area
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CHAPTER 5  ERROR INFORMATION

5. 1  Overview

If an error occurs during an operation in a window/dialog box, the following AZ:Error dialog box that displays the error 

information is displayed.

Figure 5-1  Error Information Output Format

AZ78K0R error information is shown below.

Table 5-1  Error Information List

Error Number Description

1000 Message Not enough memory.

Cause The memory required for the AZ78K0R operation is insufficient.

Action by User Close unnecessary application software and then restart the AZ78K0R.

1001 Message Internal error.

Cause An error has occurred in internal AZ78K0R processing.

Action by User Restart the AZ78K0R.

1010 Message The active window already exists.

Cause A window in the Active mode is open.

Action by User In the AZ78K0R, multiple windows of the same type cannot be open in the 

Active mode at the same time. Implement either of the following measures.

- Change the mode of the window from Active to Hold.

- Close the window in the Active mode.

1021 Message The file does not exist.

Cause No relevant files exist in the folder selected in the Open/Save As dialog box.

Action by User Specify an existing file.

Error number

Error message
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1022 Message Fail to write the file.

Cause The memory for writing to the file is insufficient, or the file subject to write is 

write-prohibited.

Action by User Implement either of the following measures.

- Delete unnecessary files.

- Specify another partition for writing.

- Change the attribute of the target file so as to enable writing.

- Specify a write-enabled file as the file subject to write.

1023 Message The file format is illegal.

Cause A file of an invalid format was selected in the Open/Save As dialog box.

Action by User In the AZ78K0R, the format of loadable files varies depending on the window 

through which the Open/Save As dialog box is opened.

 AZ:Analyze window -> Binary

 AZ:Cpu window -> CSV

1100 Message The debugger does not support AZ interface.

Cause The debugger does not support the Tool Interface Protocol (TIP).

Action by User Confirm that the debugger supports the TIP.

1110 Message Fail to switch AZ trace mode.

Cause The AZ78K0R failed communication with the debugger.

Action by User Restart the AZ78K0R and debugger.

1120 Message Fail to load the trace data.

Cause The AZ78K0R failed communication with the debugger.

Action by User Restart the AZ78K0R and debugger.

1121 Message The trace data does not exist.

Cause No information that should be stored in the trace buffer exists in the trace data 

collect section.

Action by User Expand the trace data collect section and retry collection of trace data.

Error Number Description
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